
   
March 2018 

 

 http://twitter.com/netscantools 

 

 http://www.facebook.com/NetScanTools 

 

 http://www.youtube.com/user/netscantools 

 

 http://netscantools.blogspot.com/ 

 

 

 
 

In this newsletter: 

 
News 

 

• Managed Switch Port Mapping Tool 2.80 Released March 21, 2018 

• SSL Certificate Scanner 2.51 Released March 19, 2018 

• Managed Switch Port Mapping Tool and Windows Server OS’s 

• Managed Switch Port Mapping Tool and Busy Switches 

• New NetScanTools Pro Demo Coming Soon 

• NetScanTools Pro 11.84 released January 25, 2018 

 

 

News… 
 
From the Editor… 
 

New releases are out as detailed below, and I’ll be working on the next NetScanTools 

Pro. It will be released in April. Happy Spring! 

  

-Kirk 
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Managed Switch Port Mapping Tool 2.80 Released March 21, 
2018 
 

This is a big minor release that took about 3 months to complete. Version 

2.80.1 was released a few hours later to correct a very minor one line of code 

problem. Some things you will be able to see when you use it are: 

 

• Color coding of LAG/LACP/PAGP/Trunk interfaces into groups in the Type 

column. This helps you rapidly see which member ports are used with an 

aggregator port. 

• User Defined Default Settings allow you to quickly define settings for 

switches. It now also works with device settings imports from a text file. 

• User Defined DNS is something people have asked for quite a few times. 

This lets you specify a DNS independent of your computer default DNS 

settings. 

• Bulk Settings Editor. This is found under the Settings and Tools menu and it 

lets you globally change specific switch and other settings to all become the 

same value. Use with care. 

• Port Usage Summary Table. This appears in the Switch List Final Report. It 

is used to see the physical port usage for each switch in the list. 

• Connector Present New Column. This new column is now part of the 

default set of columns. Most switches correctly report the presence or 

absence of a physical connector for the ports represented. 

• 10Scape export is now in the File menu instead of the left control panel. 

 

There are many other minor improvements and a few fixes. This is complete list. 

 

• Added colorization of LAG/LACP/PAGP/HP Trunk interface groups so that the 

user can rapidly tell which member ports belong to an aggregation port. 

 

• Added User Defined Default Settings. These can be quickly applied when 

creating new SNMP settings for a device - especially useful for businesses 

where the switches all use the same SNMP access settings. They can also be 

applied when importing a list of SNMP devices from a text file in Switch 

Lists/Device Editor. 

 

• Added a new selection in Global Settings for choosing to use the default DNS 

assigned to your computer or a specific user defined IPv4 DNS address. The 

default DNS assigned to your computer are shown. 

 

• A new summary table has been added to the Switch List Final Report (viewed 

in web browser). This shows each switch and the count of used and unused 

physical ports. This data can also be exported as XML from the Review History 

window using the new export button. Requires use the new Connector Present 

column to be active. 

 

• Added new Connector Present column to the default column list. 

 

• Added new Bulk Settings editor. This allows you to rapidly change settings on 

a global basis. For example: turning off/on Ping Sweep for all switches, 

changing the maximum number of mac addresses that can appear in a cell, 

etc. 



 

• The Export to 10SCAPE button has been removed and the functionality 

assigned to a new menu selection under the File menu. 

 

• Improved Database Maintenance Window layout. 

 

• Added method for notifying the user if it is suspected that the Bulk Reps 

(SNMPv2 and v3 only) setting is too high. 8 is the default but very busy 

switches may stop responding if the number is above 2. 

 

• Added more debugging messages. 

 

• Moved more temporary tables to the working database. 

 

• Improved the detection of a Switch versus other SNMP enabled devices. 

 

• Improved mapping speed for Cisco Small Business switches. 

 

• Improved Switch Results Analysis web page. 

 

• Reformatted dot1x column and made determinations as to whether the port 

was configured. Corrected problem with dot1x column not reloading properly 

from the history database. 

 

• Export Switch List Results to XML now includes the dot1x and Connector 

Present columns. 

 

• Improved Test Device found on the SNMP Settings window. 

 

• Improved USB version startup. 

 

• Fixed problem where two buttons did not gray out in SNMP Walk tool. 

 

• Fixed problem where Excel could not properly import from XML if the sheet 

name exceeded 31 characters. 

 

• Updated dates to 2018 

 

• Updated SQLite to version 3.22.0 

 

• Updated MAC address/Manufacturer database. 

 

 

Click on Help menu/Check for Update to get the latest version. USB version 

users will be downloading a patch – follow the directions carefully. Installed version 

users will be installing over the top of their current installed version. 

 

 

 

 

 

 

 



SSL Certificate Scanner 2.51 Released March 19, 2018 
 

This a very minor update. A user pointed out a crash when retrieving the 

certificate information from a website. It turns out that the certificate had a massive 

Subject Alternative Name field. Something like 19k worth of text instead of the 

normal few hundred bytes. We have adjusted the algorithm to allow for retrieving 

something that large. The Standalone version has been updated. The version in 

NetScanTools Pro will be updated shortly. 

 

Visit this page to download the newest Standalone version: 

https://netscantools.com/ssl-certificate-scanner-standalone.html 

 

 

 

Managed Switch Port Mapping Tool and Windows Server OS’s 
 

What you should know if you intend to use it on Windows Server. It was not 

designed with Windows Server or with multiple users in mind – it was designed for a 

single user workstation. There are some technical issues you need to be aware of. 

 

The unlock code is user based. When you enter it, the unlock code is saved on a 

per account basis, so if you unlock it as administrator, then try to run it as ‘Fred’ it 

will ask again for the unlock code. For each user account that you plan on running it 

under you will have to start it with ‘Run as administrator’ and enter the unlock code. 

 

The databases are saved in user data locations. This may change in the future, 

but for now when Admin uses the software any switch settings Admin enters cannot 

be opened by Fred. The same goes for the history database. The user databases are 

here: 

C:\Users\%username%\AppData\Roaming\NWPS\ManagedSwitchPortMapper\ 

 

To share the data, you will have to copy the databases from one location to each of 

the other login accounts. 

 

While it seems simple enough to change the location to a common user data area, it 

brings up other issues like sharing of databases in case two users try to use it at the 

same time. And licensing – it’s not licensed for concurrent use by two users. These 

are things we need to work out with user input. 

 

 

 

Managed Switch Port Mapping Tool and Busy Switches 
 

Some users have pointed out problems with using the Switch Port Mapper 

on very busy core switches. SNMP may get lower priority particularly bulk reps 

transfer requests. We have found that the default SNMP2/3 bulk transfer setting of 8 

may sometimes be too high of a number. Bulk Reps transfer setting simply means 

that for a single SNMP request we can handle up to 8 responses. In the case of the 

customer’s three stacked Cisco 3850 switches, it was not showing any mac 

addresses (or columns dependent on mac addresses) even though other data was 

showing. By reducing the bulk reps settings to 2 or 1 it worked fine. 

 

https://netscantools.com/ssl-certificate-scanner-standalone.html


Version 2.80 introduced a test to see if this is happening. If it does, you are notified. 

Reduce the Bulk Reps setting in switch settings. 

 

 

 

New NetScanTools Pro Demo Coming Soon 
 

This demo will be based on 11.84 meaning it will have the SMB Scanner in 

it. It should be complete this week. 

 

 

 

NetScanTools Pro 11.84 released January 25, 2018 
 

This release adds a new tool and enhances another. 

 

The new tool is an SMB Scanner. What does it do? It tries to connect to the SMB 

port on the target. If it connects, it asks the target which versions of SMB are 

supported. IPv4 targets and hostnames are currently supported. IPv6 will be added 

later. 

 

Back when Wannacry came around we had many requests for this type of tool. And 

this is what it looks like: 

 

 
 

What else does it do? It shows connection latency and the MAC address and NetBIOS 

machine name if the target also supports NetBT. Of course you have a right click 

menu for exporting, printing and copying results. 

 

The Network Neighbors tool was enhanced. We have observed that the local 

neighbors (remember this is IPv6 only) were not completely populated with known 

neighbors. The solution is to introduce a method of getting those neighbors to talk 



with us. There is a new button to ‘mPing’ (multicast ping) the link local network and 

get them talking. Select the network interface of interest and press the button. After 

the ping is sent it waits 10 seconds for things to stabilize to update the display. 

 

There were many other changes and fixes listed below. If you have an active 

maintenance plan you can download 11.84 through the Help menu/Check for New 

Version. 

 

Speaking of the full installer – save it in a safe place and replace any old versions. 

We constantly run across users who have reinstalled or moved their software to a 

new computer and they do so by using an old installer. Sometimes the installer is 

many, many versions older - so SAVE the latest one and discard the old ones! 

 

11.84 Release Notes 

• New SMB Scanner Tool: a launched App that accepts a set of IPv4 addresses 

or hostnames and rapidly scans them for SMB (server message block) support 

and then identifies which versions of SMB are supported beginning with 

insecure version 1. 

• Network Neighbors: Added Discover Neighbors and Refresh button which 

sends an IPv6 multicast Ping through the selected interface to rapidly find all 

link local IPv6 devices. The results get updated with the responders and show 

Entry Type 'Reachable'. 

• DNS Tools - Advanced: fixed gray out of IPv6 Address Validation button. 

• Firewall Rules: Parsing of UDP protocol corrected. 

• File menu/Accessibility: corrected operation of left control panel operation 

when a tool is selected. Added missing tools and added SMB Scanner. 

• RFC Reference: several RFCs added. 

• Whois: Remove Legal Notices and Advertising checkbox state is now retained. 

Results text 'jumping' issue has now been fixed - if you did a Whois, then 

scrolled to the bottom and tried to select text, it would jump back to the top 

without selecting the text - but only the first time you tried to do it. 

• Changed methods of determining which operating system is hosting the 

software. 

• USB Version only: improvements for software launch process. 

• Updated SQLite to version 3.22.0 

• Updated MAC address/Manufacturer database. 

• Updated IP to Country database. 

• Updated dates in all programs to 2018. 

 

 

 

Contact Information 

 

If you have any questions or suggestions, please feel free to email. 

 

Northwest Performance Software, Inc. 

PO Box 1375 

Sequim WA 98382 



(360) 683-9888 

www.netscantools.com 

sales [at] netscantools [dot] com 

 

'NetScanTools Pro', 'NetScanTools Standard', ‘NetScanTools Basic’, 

'NetScanTools LE', 'ipPulse', 'Northwest Performance Software' and 

'NetScanTools.com', are trademarks of Northwest Performance Software, Inc. 

'NetScanTools' is a registered trademark of Northwest Performance Software, 

Inc. 

 

Other names and trademarks are the property of their respective owners. 
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